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Introduction 
The SimCity 2000 Urban Renewal Kit—a.k.a. SCURK—is the 
ultimate utility for the ultimate city simulator. Building and 
editing cities and terrain for your Sims was only the 
beginning. Now you can: 

• Build a SimCity 2000 city from scratch, or modify any 
pre-built city your way, without any money, population, 
time or developmental constraints. Put buildings, roads, 
subways...you name it...anywhere, any time, for any 
reason. 

• Enhance, modify, and otherwise embellish the original 
SimCity 2000 artwork, and even design your own. 

• Mix and match the original SimCity 2000 buildings with 
your own art to create custom object sets that you can 
load into SimCity 2000. 

• Print out your city in any of three sizes, above or below 
ground, and showing (or not) any layers you choose. 

Still not enough for you? Well then, as an added bonus, the 
talented folks in our art department have created an entirely 
new, futuristic set of graphics for your enjoyment and editing 
pleasure. 

SCURK is an add-on to SimCity 2000. It won't install or work if 
you don't have SimCity 2000. You'll have a lot more fun with 
SCURK if you are already familiar with SimCity 2000, so if you 
haven't played SimCity 2000, set this manual down and go 
play. Once you have a feel for the game, you'll have a better 
feel for designing buildings and cities in SCURK. 

SCURK and 
SimCity 2000 
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SCURK and Future 
Maxis Computer 

Games 

Installing and 
Starring SCURK 

A [Really Small] 
Warning 

Not only will SCURK help you get more out of SimCity 
2000...it'll help you get more out of a number of other yet-to-
be-released games as well. SCURK will work with and 
enhance a number of future Maxis games. You'll be able to 
use SCURK to create city raceways for driving simulations, 
targets and obstacle courses for flying simulations, and the 
playfields for games that...well, you'll just have to wait and 
see. 

When you install SCURK, all the necessary changes are made 
to your copy of SimCity 2000 so you can use the new 
graphics we provide or the ones you create. See the SimCity 
2000 Urban Renewal Kit Quick-Start Guide for complete 
instructions for installing and starting SCURK on your 
computer. 

Some of the windows on your computer, and some of the 
object names, may be a little different than how they appear 
in the manual. This won't have any affect at all on how the 
utilities and objects work. 
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The SCURK 
Window 

SCURK consists of three utilities, each in their own window. 
To activate a utility, either click on it, or select it in the 
Window menu. 

Paint the Town is a special-
ized paint program that lets 
you create new graphics or 
enhance old ones from either 
the original or Future City set. 

Pick & Copy lets you mix and 
match different graphics. 

Place & Print lets you design, 
modify, plan, model or other- 
wise shape a city, and print it out in three different sizes. 

Before jumping into the program, here are some helpful 
definitions: 

Objects—Objects are things that appear in SimCity 2000 that 
can be modified in SCURK. They include buildings, roads, 
rubble, animated objects and a few other things. 

Object Set—An Object Set is a file containing one or more 
objects. In SCURK, you will be able to copy objects from set 
to set. 

Working Object Set—The Working Object Set is the Object 
Set that you are currently modifying. The Working Object Set 
is available to all three utilities. Changes you make to the 
Working Set in one utility are immediately reflected in the 
other utilities. 
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Paint the Town Paint the Town is a specialized paint program that lets you 
create your own graphics for the objects (buildings, etc.) in 
SimCity 2000. You can create artwork from scratch or you 
can start with the original or Future City sets and modify them. 

Note: Changing the look of the objects does not in any 
way change the way the SimCity 2000 simulation 
works or the game plays. This means you can get as 
weird and wild as you want with your object designs 
and it'll always work. In the words of the Immortal 
Bard, "A Braun Llama Dome by any other visual 
representation would still smell as sweet." (At least to 
your Sims.) 

Here are a couple more useful definitions for understanding 
Paint the Town: 

Tiles—A tile is a measurement of area in SimCity 2000. Tiles 
are the little squares on the ground. 

Base Size—Each object has a pre-set, unchangeable base 
size that limits its width and depth. Some objects have a 
base size of 1 x 1 tile, others are 2 x 2 , a few are 3 x 3, and 
the biggest ones are 4 x 4. Even the animated, moving objects 
that don't sit on the ground (like planes and ships) are 
limited to their base tile size. 
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When the Paint the Town utility window is maximized, you 
will see this screen, where you can create brand new 
graphics for SimCity 2000 from scratch, or load in an existing 
set to modify. 

Paint the Town works like most computer paint programs, 
with a couple of special tools to make it easier to draw in the 
proper perspective for SimCity 2000. The basic process is to 
choose the tool you want to use from the Toolbox, choose 
the color you want to use from the palette, then paint in the 
Drawing Area. Your work will simultaneously be displayed in 
all three SimCity 2000 zoom sizes. 
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The Tools Here's an explanation of all the drawing tools in the Toolbox. 
If you are familiar with other computer paint programs, 
you'll master Paint the Town in no time. If not, then read 
through this section of the manual and play through the 
tutorial, and you'll master it in almost no time. 

Free Drawing Tool—Turns your cursor into a free-style 
drawing tool. Click or click and drag the mouse in the 
Drawing Area to use it. While active (and within the Drawing 
Area), the cursor will appear as a pencil. The size of dots and 
lines that this tool draws depends on the brush size. 

Eraser—Turns your cursor into an eraser. Click or click and 
drag the mouse in the Drawing Area to use it. While active 
(and within the Drawing Area), the cursor will appear as an 
eraser. The area that this tool erases depends on the brush 
size. 

Line—Draws a straight line at any angle. Click and hold to 
begin the line, drag the mouse to define the line, then release 
the mouse button to draw the line. While active (and within 
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the Drawing Area), the cursor will appear as a crosshair. The 
thickness of the line depends on the brush size. 

Diamond—Draws diamond shapes. Click and hold to choose 
one corner of the diamond, drag the mouse until the 
diamond is the size you want, then release the mouse button. 
While active (and within the Drawing Area), the cursor will 
appear as a crosshair. The thickness of the diamond's 
outline depends on the brush size. When this button is 
active, click it again to open a submenu that lets you choose 
between a hollow diamond and a filled diamond. 

Left Wall—Draws parallelograms that make it easy to draw 
left walls of buildings in the proper perspective for SimCity 
2000. Of course, you can use it for things other than left walls 
if you choose. Click and hold to choose one corner of the 
wall, drag the mouse until the wall is the size you want, then 
release the mouse button. While active (and within the 
Drawing Area), the cursor will appear as a crosshair. The 
thickness of the wall's outline depends on the brush size. 
When this button is active, click it again to open a submenu 
that lets you choose between a hollow left wall and a filled 
left wall. 

Right Wall—Draws parallelograms that make it easy to draw 
right walls of buildings in the proper perspective for SimCity 
2000. Naturally, you can use it for things other than right 
walls if you choose. Click and hold to choose one corner of 
the wall, drag the mouse until the wall is the size you want, 
then release the mouse button. While active (and within the 
Drawing Area), the cursor will appear as a crosshair. The 
thickness of the wall's outline depends on the brush size. 
When this button is active, click it again to open a submenu 
that lets you choose between a hollow right wall and a filled 
right wall. 
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Circle—Draws circles and ellipses. Click and drag the mouse 
until the circle is the size—and shape—you want, then 
release the mouse button. While active (and within the 
Drawing Area), the cursor will appear as a crosshair. The 
thickness of the circle's outline depends on the brush size. 
When this button is active, click it again to open a submenu 
that lets you choose between a hollow circle and a filled 
circle. 

Box—Draws squares and rectangles. Click and drag the 
mouse until the box is the size—and shape—you want, then 
release the mouse button. While active (and within the 
Drawing Area), the cursor will appear as a crosshair. The 
thickness of the box's outline depends on the brush size. 
When this button is active, click it again to open a submenu 
that lets you choose between a hollow box and a filled box. 

Fill—Fills an area with the selected color, cycle, or texture. It 
begins where you click in the Drawing Area and fills in all 
directions until it comes to another color. Fill considers each 
color of a color cycle pattern to be a different color, so filling 
over color cycled areas isn't very effective. While active (and 
within the Drawing Area), the cursor will appear as a 
crosshair. 

Eyedropper (Color Picker)-Lets you set the brush color by 
selecting a color in the Drawing Area (so you don't have to 
find the color in the palette). Click on the color you want. 
While active (and within the Drawing Area), the cursor will 
appear as a crosshair. 

Zoom Out—Lets you "step back" from your drawing in the 
Drawing Area for a big picture look of your work. There are 
four zoom levels. These are zoom levels above and beyond 
the three zoom levels that appear in SimCity 2000. They exist 
to make drawing easier, and do not affect the actual artwork. 
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Zoom In—Moves  you up close in the Drawing Area for those 
dot-by-dot corrections which can make all the difference 
between good work and great art. There are four zoom 
levels. These are zoom levels above and beyond the three 
zoom levels that appear in SimCity 2000. They exist to make 
drawing easier, and do not affect the actual artwork. 

Copy—Lets you make a copy of any portion of any object in 
the Drawing Area. Click and drag the cursor to outline the 
part of the object you want to copy. When you release the 
mouse button, your cursor becomes a "brush" composed of 
the copy, and SCURK automatically changes to the Paste 
tool. Click to paste the copy, or click and drag to paint with 
the brush. While active (and within the Drawing Area), the 
cursor will appear as a crosshair until something is copied. 
You can manipulate the copy (rotate or flip) with tools in the 
Edit menu before you paste it. The copy is kept on the clip-
board until you copy something else. 

Paste—Lets  you paste what you have copied (from the 
Drawing Area or to the clipboard from another program) into 
the Drawing Area. It is automatically selected by SCURK right 
after you copy something with the Copy tool. The copy is 
kept in memory until you copy something else, so you can 
use different tools and even load another Object Set, then 
return to Paste and still have the copy to paste. 
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The Palettes Brush Color—Shows the current color and texture pattern 
of the brush. 

Brush Size—Lets you set the size and/or 
thickness of the dots, lines and shapes you 
draw (or erase) to a one-, two-, three-, four-, 
five- or six-pixel square. You also have round 
brushes which are four- and five-pixels in 
size. Brush Size affects the free drawing tool, 
eraser tool, line tool, and all the shape tools. 
Larger brush sizes soften the corners of the 
Diamond, Left Wall and Right Wall shapes. 

Texture Palette—Lets you choose from a 
selection of pre-designed texture patterns. 
Click on a texture to chose it. A red square 
marks the active texture. The three textures 
across the top of the palette use solid colors. 
The first one (white) uses only the 

foreground (f) color. The second one (gray) mixes 
foreground and background (b) colors together. The third 
one (black) uses only the background color. All other 
textures use both foreground and background colors to 
create their patterns. 

Color Palette—Shows the electronic "paints" available for 
your works of art. Click on a color with the left mouse 
button to select a foreground color, and the right mouse 
button to select a background color. (Macintosh users 
should click the mouse button to select a foreground color, 
and hold down the Option key and click the mouse button 
to choose a background color.) The color cycle patterns are 
at the end of this palette. 

Note: See Appendix for more information on colors, 
palettes and color cycling. 

Page 10 SimCity 2000 Urban Renewal Kit — Paint the Town 



The Drawing Area The Drawing Area is where you modify our graphics and 
create your own. Objects in the Drawing Area are displayed 
larger than they'll be in SimCity 2000, 
so you can more easily see the details 
while drawing them. The display size 
can be adjusted with the Zoom In and 
Zoom Out tools in the Toolbox. 

BASE SIZE, HEIGHT LIMIT 

AND THE CLIP REGION 

Each object (even when it is blank) 
has a set base size. Base sizes can be 
one, two, three or four tiles square. 
The Drawing Area always displays a 
four-by-four base, but you can't always use the whole base—
only as much of the base as the object you are drawing or 
editing has. Base sizes cannot be changed. The base size is 
displayed in the Paint the Town title bar, along with the 
object name. 

Each object also has a height limit, which is the top of the 
Drawing Area. No object can extend beyond the top of the 
Drawing Area. 

SCURK will instantly and automatically erase (clip) anything 
you draw or paste outside an object's base size or above the 
Drawing Area. 

An easy way to keep track of both 
the base size and the height limit 
while painting an object is to turn 
on the Clip Region display. 

The Clip Region is a grid that de-
fines the part of the Drawing Area 
that can be used for a particular 
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object. It is always active, but is only displayed when you 
want to see it. To turn on the Clip Region display, open the 
Options menu and select Show Clip Region. Select it again to 
turn it off. 

The View Windows These windows show the entire Drawing Area, and display 
what your finished products will look like in the three 
SimCity 2000 zoom levels. These windows are for display 
only. You can't draw in them. 

Note: you only have to draw each object once and 
SCURK automatically converts it to all three sizes 
for you. 
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The Paint the Town Object Selector is where you choose the 
object you want to work on in the Drawing Area. The original 
objects are loaded by default. Here's how to use the object 
selector: 

1. Click on either arrow in the Object Selector until you see 
the object you want to edit. (If you hear a little "bell" 
when you click an arrow, it means you are at one end of a 
group of objects. Simply click the other arrow.) 

2. Click on the object you want to edit to load it into the 
Drawing Area, ready for creative talents to go wild. 

3. If you want to edit a different set of objects, open the File 
menu, select Load..., then choose Working Object Set. A 
dialog box will open and you can choose the object set 
you want to edit. 

Object Selector 

Below the Object Selector is the Information Line. This area 
provides a brief explanation of the highlighted Menu item. It 
also displays the coordinates of the drawing tool within the 
Drawing Area. Position 0/0 is the top-left and 128/256 is the 
bottom-right corner of the Drawing Area, regardless of base 
tile size. 

Information Line 
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The Paint the 
Town Menu Bar 

Since the SCURK utilities share the same information, they 
share many of the same menus and menu functions. Each 
utility also has some menu items which are unique to that 
utility. Here's a list of the Paint the Town Menu items and 
what they do: 

FILE MENU 
Load has three submenu items: 

City...—Loads a previously saved city terrain for use in 
Place & Print. 

Source Object Set...—Loads a source object set for use 
in Pick & Copy. 

Working Object Set...—Loads the Working Object Set 
used in all three SCURK utilities. 

Save has two submenu items: 

City—Saves the city terrain used by Place & Print under 
its current name and path. 

Working Object Set—Saves the Working Object Set 
under its current name and path. 

Save As has two submenu items: 

City...—Lets you change the name or path (or both) of 
the city terrain used by Place & Print. 

Working Object Set...—Lets you change the name or 
path (or both) of the Working Object Set. 

New has two submenu items: 

City—Loads an unnamed, blank, flat city terrain for use 
in Place & Print. 

Working Object Set—Loads a clean, unblemished copy 
of the original object set as the Working Object Set. 
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Export BMP File...—Exports  the Object in the Paint the 
Town Drawing Area as a BMP file. 

On Macintosh computers, this menu item reads Export PICT 
file.... 

Print Setup...—Opens  a dialog box which allows you to 
change certain aspects of how your printer will function. 

Print City...—Opens  a dialog box which allows you to print 
some or all of the city which is loaded in Place & Print. 

Exit—Closes  SCURK (after prompting you to save any 
changes you made). 

EDIT MENU 
Undo—Removes the result of the most recent mouse action 
from the Drawing Area. 

Copy—Lets you make a copy of any portion of an object in 
the Drawing Area. 

Paste—Lets you paste what you have copied (either with the 
Copy tool or to the clipboard) into the Drawing Area. 

Clear—Erases the contents of the Drawing Area and leaves 
clean ground and clear sky. 

Revert—Returns the object in the Drawing to the state it was 
in when you brought it into the Drawing Area. Revert only 
works on one object at a time. You must use it before you 
change objects—no "go backs." 

Undo or Revert? Undo removes the results of only the 
most recent mouse click. For example, if you were to 
draw a circle, Undo would remove it. If you draw a 
circle and then a box, Undo would remove the box. 
Revert removes work you have done since you brought 
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an object into the Drawing Area. For example, if you 
draw a circle and then a box, Revert removes both of 
them. If you draw something and then load another 
object into the Drawing Area, and then load the first 
object again, Revert does not remove what you drew 
previously. 

Rotate—Rotates  what you have copied to the clipboard 90 
degrees counter-clockwise. Select it again for an additional 
90-degree rotation. This item is "ghosted" if the Paste tool is 
not selected or if the clipboard is empty. 

Flip Horiz—Flips  what you have copied to the clipboard 180 
degrees horizontally. (Left becomes Right.) This item is 
"ghosted" if the Paste tool is not selected or if the clipboard 
is empty. 

Flip Vert—Flips  what you have copied to the clipboard 180 
degrees vertically. (Top becomes Bottom.) This item is 
"ghosted" if the Paste tool is not selected or if the clipboard 
is empty. 

Rename—Opens  a dialog box that allows you to change the 
name of an object. (This is the name that appears in the 
query box of SimCity 2000.) 

Revert Name—Returns the original name of an object to that 
object. 

OPTIONS MENU 
Grid Settings...—Lets  you set how fine your drawing grid will 
be so you can more easily line up shapes with each other in 
the drawing area. 

Snap to Grid—Forces  the shapes you draw to line up along 
the grid pattern. 
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Show Grid—Toggles  the Snap to Grid pattern so you can see 
how your objects will line up when you draw them. This grid 
is for display only. It won't become part of an object's 
artwork. 

Show Clip Region—When  selected, displays the Clip Region 
for the object currently in the Drawing Area. 

Cycle Colors—Toggles  the color cycling on and off, which 
can make it easier to use for animation. (Sometimes those 
flashing colors can get annoying). This affects color cycling 
only in Paint the Town. 

Increment Cycle—Lets  you "step through" the Paint the 
Town color cycle patterns for easier animation. This affects 
color cycling only in Paint the Town. You can only use it 
when color cycling is turned off. 

Sound Toggle—Toggles  the sounds for SCURK tools and 
sound -effects of the objects. This only affects objects when 
they are in SCURK. 

OBJECT GROUP MENU  
This menu lets you select a group of objects from the 
currently loaded object set. The selected group will appear 
in the Object Selector. 

WINDOW MENU  
Cascade—Overlaps the SCURK utility windows. Click the title 
bar of the utility you wish to use to activate. 

Paint the Town—Activates the Paint the Town utility. 

Pick & Copy—Activates the Pick & Copy utility. 

Place & Print—Activates the Place & Print utility. 
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Paint the Town 
Notes and 
Guidelines 

OBJECTS YOU CAN'T MODIFY 

The following objects cannot be altered in SCURK: 

• Roads 	 • Highways 

• Onramps 	 • Tunnels 

• Rails 	 • Subways 

• Trains 	 • Sub-to-Rail Connectors 

• Power Lines 	 • Water Pipes 

• Bridges 	 • Wire Crossings 

• Water Tiles 	 • Ground Tiles 

• Hillside Tiles 	 • Signs 

• The Alien 	 • Small Parks 

• Small Boats 	 • Helicopters 

• Zone Indicator Colors 	• Police, Fire and Military 

• Airport Runways 	 Dispatch Icons 

IMPORTING GRAPHICS 

You can import graphics into Paint the Town. If you can load 
them (or draw them) in any graphics program and copy 
them to the clipboard, you can paste them into the Paint the 
Town Drawing Area. 

IMPORTED GRAPHICS AND COLOR 

Palettes are tricky things, especially when you import 
graphics from other programs. Both SimCity 2000 and SCURK 
have a set 256-color palette that reserves a number of places 
for color cycling. This palette is not changeable in either 
SimCity 2000 or SCURK. 

When you import graphics from another program into 
SCURK, SCURK will do its best to match each color in the 
imported graphic to a color in the SimCity 2000 palette. 
Depending on the original palette, this might work 
perfectly—or it might leave some colors looking strange. You 
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can either touch up the colors you don't like, or leave them 
alone and call it art. Your Sims won't care one whit about 
how strange the colors are. 

If you want to use another paint program to draw or put the 
finishing touches on objects, it's best to use the right palette. 
You can do this by first exporting an object with the Export 
BMP... on Windows computers or Export PICT... on 
Macintosh computers option in the File menu, then loading 
that file into your other paint program. The palette will be 
included in the exported file. Most paint programs will also 
let you copy the palette from another file, so you can get the 
correct palette for your other program from the sample BMP 
or PICT file. In any event, even with the right palette, the 
color cycling won't appear in your other paint program, and 
you might use the cycle colors by accident. The best thing to 
do is to start objects in SCURK, export them for detailed 
touch-up in another program (if you have one you really 
really like), then bring it back into SCURK for final color test 
and touch-up. 

OBJECTS AND THE SIMCITY 2000 SIMULATION 

• You can make any of the buildings look any way you 
want, but remember that each of the buildings (and 
other objects) has a specific meaning to the SimCity 2000 
simulation. For the most part, the functions of all the 
objects in the Specials, Power, Transport & Military and 
Misc. Ground object groups are pretty obvious. But 
you'll need to take a little care when dealing with the 
objects in the Residential, Commercial and Industrial 
groups. Each of these buildings is selected by the 
simulation and put into a SimCity 2000 zone based 
primarily on population density, with minor variations 
for land value. 

• As a rule of thumb, any residential, commercial or 
industrial building that has a one-by-one base size is low 
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density. A building with a three-by-three base size is high 
density. Buildings with two-by-two base sizes are 
medium density (some are low-medium and others high-
medium). 

• Each object has two names. The full name that appears 
in the Paint the Town title bar is similar to name that will 
appear in SimCity 2000 in the Query windows. This is the 
name that you can edit to suit your creative whims and 
spelling abilities. More than one object may have the 
same full name. The other name is a shortened version 
that appears only in SCURK within the Object Selector to 
help you pick the object you want to work on. Each 
shortened name is different to help you tell them apart 
and to help you understand how the objects are used by 
the simulation so you can take it into account when you 
draw the objects. In these shorter names, L=Large, 
M=Medium and S=Small. Some of the animations in the 
Animated I object group consist of multiple frames. Their 
shortened names are labeled A, B, C, etc., to show their 
frame order. The objects in the Animated II object group 
show the object moving in different directions. Their 
shortened names indicate their direction: N=facing north 
(up), E=facing east, NE=facing northeast, SE=facing 
southeast, S=facing south. (When these objects need to 
face the other directions, SimCity 2000 flips them.) 

COPYING AND PASTING  

• You can edit only one object at a time, but you can copy 
and paste between different objects and groups within 
different object sets. 

• You can only copy what is showing in the Drawing Area. 
You cannot scroll through the drawing area while copy-
ing. Use Zoom Out to Copy large objects, including entire 
buildings as long as they fit within the Drawing Area. 
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COLORS AND COLOR PALETTES 

• As the "F" stands for "foreground," the "B" in the color 
palette stands for "background." The letters "F" and "B" 
simply distinguish between two colors which can both 
exist in a texture pattern. It does not indicate such things 
as the background of the Drawing Area for example, or 
that one color is "in front" of or "behind" another. 

• The foreground and background can be the same color. 
When using the solid texture, the color of the brush is 
always the "foreground" color. 

• The colors in the palette and cycle patterns are fixed and 
are not user alterable. Sorry. 

• Regardless of how the color cycles "move" in the display, 
cycle direction is determined by the order in which the 
colors are plced on an object. For example, if color 
number two of a pattern is placed above color one, and 
color three is placed above color two, and so on, 
"motion" is from bottom to top. 

• Any steady color or color of a cycle pattern can be either 
background or foreground for any texture pattern. Mix 
and match color cycles, steady colors and textures for 
truly garish effects. 

• See Appendix for additional information on colors, 
palettes and color cycling. 
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Pick & Copy The Pick & Copy utility lets you mix and match objects from 
the original object set, the future set and your own sets 
(from Paint the Town) to create new object sets. You can 
save them to disk and use them in SimCity 2000 to provide 
your Sims with your own particular (or peculiar) 
architectural interpretations. 

The steps for using Pick & Copy are: 

1. Pick a Source Object Set. This can be the original set, the 
future set or any set you have created on your own in 
Paint the Town. 

2. Pick a Working Object Set to build. This could be the set 
you most recently worked on in Paint the Town, any 
other existing object set, or a new, blank object set. 

3. Copy objects, one-by-one or in groups from the source to 
the working set. You can change the source object set if 
you want to mix and match objects from a number of 
sources. 

4. Save the working set to disk. You can load a different 
working set at any time to build a library of object sets. 
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As soon as you activate Pick & Copy, you'll see this screen. 
The number of objects our Object Selectors show will 
depend on how you size your window and the resolution you 
are using. Your Source Object Set name may be different: 

Picking and 
Copying 

This screen lets you pick individual objects or object groups 
in the Source set and copy them into the Working set. Once 
you've got your Working set exactly the way you want it, you 
should save it to disk. Open the File menu and select Save or 
Save As..., then select Working Object Set. The Working 
Object Set you create is the one that will be used by Place & 
Print (unless you choose to load another one). 
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PICKING AND COPYING INDIVIDUAL OBJECTS 
You can only copy from the Source set to the Working set. 
Here's how: 

1. Locate the object(s) in the Source set that you want to 
copy to the Working set. 

Open the Object Group menu and select the object group 
that contains the object(s) you want to copy. The same 
object group is always displayed in both the Source and 
Working object selectors, even though the individual 
objects may be different. Click on the Selector Arrows 
until the object you want to copy is showing. 

2. Select the object(s) that you want to copy to the 
Working set. 

Click on the object or objects in the Source Object selec-
tor that you want to copy. Both the Source and Working 
instances of the object(s) will be highlighted. The Source 
set will have a thick border and the Working set will have 
a thinner border. Hold the Ctrl key (for Windows) or the 
Control key (for Macintosh) and click on multiple objects 
to select them. Hold the Shift key and drag your mouse 
across a row of objects to select them. Click on a 
selected object while holding the Ctrl key (for Windows) 
or the Control key (for Macintosh) to de-select it. 

3. Copy the Selected Object(s). 

Open the Edit menu and choose either Copy Selected or 
Copy All. You can also drag the highlighted objects from 
the Source set to the Working set. If you are copying 
more than one object, SCURK will automatically put 
selected objects from the Source set in their proper 
place within the Working set. You'll get a dialog box 
confirming what you want to copy. After objects are 
copied, they are de-selected. 
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4. Select another Source and repeat. 

If you want your Working set to include individual 
objects from other Source files, then open the File menu, 
select Load Source... and select the new Source file. 
Repeat steps one through three until your Working set is 
complete. 

PICKING AND COPYING OBJECT GROUPS  

Copying entire Object Groups is very similar to copying 
individual objects. Just follow these steps: 

1. Select the object group you want to copy from the 
Source set to the Target set. 

Open the Object Group menu and select the group you 
want to copy. Select All Objects if you want to copy the 
entire object set from the Source set to the Working set. 

2. Open the Edit menu and select Copy All. 

The selected object group will be copied from the Source 
set to the Working set. If you choose All from the Object 
Group menu, the entire Source Object Set will be copied. 
You'll be asked to confirm your action. 

3. Select another Source and repeat. 

If you want your Working set to include object groups 
from other Source files, then open the File menu, select 
Load and then Source..., and load a new source object 
set. Repeat steps one and two until your Working set is 
complete. 

SAVING THE WORKING OBJECT SET TO DISK 

AND USING IT WITH SIMCITY 2000  

Once your Working Object Set is complete, you can save it to 
disk as an object set by selecting Save or Save As... from the 
File menu, and then Working Object Set. You'll be able to 
load it as an alternate graphic set when you next start 
SimCity 2000. 
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The Pick & Copy 
Menu Bar 

The SCURK utilities share many of the same menus and 
menu functions. Each utility also has some menu items 
which are unique to that utility. Here's a list of the Pick & 
Copy Menu items and what they do: 

FILE MENU  
Load has three submenu items: 

City...—Loads  a previously saved city terrain for use in 
Place & Print. 

Source Object Set...—Loads  a source object set for use 
in Pick & Copy. 

Working Object Set...—Loads  the Working Object Set 
used by the three SCURK utilities. 

Save has two submenu items: 

City—Saves the city terrain used by Place & Print under 
its current name and path. 

Working Object Set—Saves  the Working Object Set 
under its current name and path. 

Save As has two submenu items: 

City...—Lets  you change the name or path (or both) of 
the city terrain used by Place & Print. 

Working Object Set...—Lets  you change the name or 
path (or both) of the Working Object Set. 

New has two submenu items: 

City—Loads an unnamed, blank, flat city terrain for use 
in Place & Print. 

Working Object Set—Loads the original object set as the 
Working Object Set. 

Print Setup...—Opens  a standard dialog box that allows you 
to change certain aspects of how your printer will function. 
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Print City...—Opens  a dialog box that allows you to print 
some or all of the city that is loaded in Place & Print. 

Exit—Closes  SCURK (after prompting you to save any 
changes you made). 

EDIT MENU 
Copy Selected—Copies  all the objects you have selected 
from the Source Object Set to the Working Object Set. 

Copy All—Copies  the entire group of objects that you have 
loaded from the Source Object Set to the Working Object Set. 
If you selected "All" from the Object Group menu, then the 
entire object set will be copied from the Source to the 
Working Object Set. 

OBJECT GROUP MENU 

This menu lets you select a group of objects from the 
currently loaded object set (including new or blank sets). 
The selected group will appear in the Object Selector. 

WINDOW MENU 
Cascade—Overlaps  the SCURK utility windows. Click the title 
bar of the utility you wish to use to activate that utility. 

Paint the Town—Activates the  Paint the Town utility. 

Pick & Copy—Activates the Pick & Copy utility. 

Place & Print—Activates the Place & Print utility. 

Below the object selector is the Information Line. This area 
provides a brief explanation of the highlighted Menu item. 

Information Line 
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Pick & Copy Notes 
and Guidelines 

FROM SOURCE TO WORKING 

You can only copy objects from the Source Object Set to the 
Working Object Set. You cannot copy from the Working 
Object Set to the Source set. Any object set can be either 
Source or Working. You can even use the same set as both 
the Source and the Working. 

You can only copy from a particular Source object or objects 
to the same particular Working object or objects. No matter 
how you drag highlighted objects, Pick & Copy will always 
copy the Source objects you have selected to their proper 
place in the Working set. 

Nothing you do has any effect on the Source Object Set. You 
cannot copy objects to the set you have loaded as the 
Source set, nor can you save the Source set. If you want to 
make changes to an object set, it must be loaded as the 
Working set. 
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Place & Print has two functions: 

• It allows you to completely model a city's terrain, and 
provide buildings, infrastructure and all that other city 
stuff without the annoying money, time and population 
constraints of SimCity 2000. 

• It prints part or all of your city in any of three sizes, in 
color or black and white. 

Big Big Warning!! Place & Print gives you complete 
freedom to place any road, zone, building, object or 
whatever anywhere you want—BUT once you load 
your creation into SimCity 2000, don't be surprised 
when the buildings you so carefully placed start to 
decay or disappear. Place & Print leaves you open to 
explore beautiful and impossible cities and print them 
out, but it doesn't convince the Sims to like them. 
(That's controlled by the SimCity 2000 simulation and 
is not changed by SCURK) But Place & Print serves 
another purpose: beyond designing impossible cities 
(and customizing possible ones) it will let you create 
the playfields for future Maxis games, including driving 
and flying simulations and... well, just wait and see. 

Here's the screen you'll use for Place & Print: 

When you first enter 
Place & Print (and if you 
haven't already loaded a 
city), the terrain is 
completely empty and 
flat, ready to be molded 
to suit your fancy. You 
can leave it flat for 
maximum city size, or 
sculpt it with the Edit 
tools. You can also load 
cities created with either 
SCURK or SimCity 2000. 

Place 	Print 
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Note: The graphics displayed in Place & Print are 
those currently loaded as the Working Object Set. To 
change the graphics for placing or printing, simply 
open the File menu, select Load and then select 
Working. 

The Object 
Selector 

The Place & Print Object Selector lets you choose and place 
individual objects (buildings, parks, and the like) anywhere 
you want in the city. To use it: 

1. Open the Object Group menu and select a group of 
Objects (the default is All Objects, beginning with the 
Residential Group). 

2. Click on either arrow in the Object Selector until you see 
the object that you want to place. 

3. Click on that object to select it. 

4. Click in the Work Area to place the object. 

The Place & Print Object Selector is a movable window. This 
lets you move it out of your way and view more of your city 
when you are building. 
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The Toolbox contains items that are very similar to their 
counterparts in the SimCity 2000 toolbox, with just a few 
differences: 

• If a tool button has several functions, the previous 
function used will be activated when you click that 
button. Click the button again to open a submenu of 
additional functions. 

• Water (ponds, rivers, lakes) and water pipes have been 
combined in one tool. 

• The placement of all zones, including seaports, airports 
and military, has been combined into one tool. 

• Every object—except those in Animated I and Animated 
II—that you can modify in SCURK (including trees, power 
plants, bus depots, rail and subway stations, schools, 
police and fire stations, etc.) is chosen from the Object 
Selector. 

The Toolbox 

Note: The Terrain toolbox in SimCity 2000 has more 
extensive terrain modification tools. If you need more 
earth-moving power than SCURK has, then, in SimCity 
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2000, select Edit New Map from either the Startup 
dialog box or the File menu, make all the major 
modifications you want, and save it to disk. You can 
then load it into SCURK for adding city infrastructure 
and objects. 

BULLDOZER 
The Bulldozer is your main tool for molding the land as well 
as a source of destructive delight. Click once to use the most 
previously used function. Click again for a submenu of these 
functions: 

Demolish/Clear is the default function. It destroys and 
removes objects without altering terrain or zoning 
status. Click on anything to destroy it. The Place & Print 
Bulldozer does not leave rubble. 

Level Terrain lets you choose an altitude level by 
clicking and holding on terrain in the Work Area which 
has the altitude you want. Click on terrain that has the 
altitude you want, then move the mouse (without 
releasing the mouse button) to slice off hills and fill 
valleys to make them your chosen height. When terrain 
is leveled, any objects built on that terrain are removed. 

Raise Terrain lets you build hills, mountains and 
plateaus. When terrain is raised, any objects built on that 
terrain are removed. 

Lower Terrain lets you dig canyons and remove 
mountains. When terrain is lowered, any objects built on 
that terrain are removed. If you lower the terrain below 
sea level, it will fill with water. 

De-zone lets you change undeveloped residential, 
commercial, industrial, seaport and airport zones to 
unzoned land. 
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WATER TOOL 

The Water tool lets you place water on the terrain and water 
pipes underground. Click once to use the most previously 
used function. Click again for this submenu of options: 

Pond/Lake/River lets you "paint" water on your terrain. 
Use it to place lakes, rivers, coastal areas and water falls. 
The cursor is a water drop when this function is active. 
The Pond/Lake/River option does not lower terrain. 

Pipes lets you place underground water pipes. Choosing 
this option automatically changes the Work Area to the 
Underground view so you can see where your pipes are 
going. Your cursor is a water faucet when this function is 
chosen. 

Note: The Water Pump, Water Tower, Water Treatment 
Plant and Desalinization Plant, which are part of the 
SimCity 2000 water system, are placed with the Object 
Selector. They are in the Specials group. 

ZONE TOOL 

The Zone tool lets you place nine zone types. Click once to 
choose the most previously used zone. Click again to choose 
between these types of zones: Light Residential, Dense 
Residential, Light Commercial, Dense Commercial, Light 
Industrial, Dense Industrial, Seaports, Airports and Military. 

Note: All the Military objects are in the Transport & 
Military Group. 
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ROAD TOOL 

The Road tool lets you place roads and related functions. 
Click once to use the most previously used function. Click 
again to chose between Road, Highway, Tunnel and 
Onramp. 

Note: The Bus Depot, which is part of the Road tool in 
SimCity 2000, is placed with the Object Selector. It is in 
the Transport & Military group. 

RAIL TOOL 

The Rail tool lets you place rails and related functions. Click 
once to use the most previously used function. Click again to 
chose between Rail, Subway and Subway to Rail 
connections. 

Note: The Rail Station and the Subway Station, which 
are part of the Rail tool in SimCity 2000, are placed 
with the Object Selector. They are in the Transport & 
Military group. 

POWER LINE TOOL 

The Power Line tool lets you paint power lines. There is no 
submenu. 

Note: Power Plants, which are part of the Power tool in 
SimCity 2000, are placed with the Object Selector. 
They are in the Power group. 

ROTATE COUNTER-CLOCKWISE 

Click to rotate the entire city map 90 degrees counter-
clockwise. 

ROTATE CLOCKWISE 

Click to rotate the entire city map 90 degrees clockwise. 

ZOOM OUT 

Click to "step back" for a big picture look at your city. 
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ZOOM IN 

Click to move in for a detailed look at your city. 

CENTER TOOL 

The Center tool lets you pick a place in your city to be 
centered in the Work Area. Activate the tool and click 
anywhere in the Work Area. 

SHOW UNDERGROUND VIEW 

Click to toggle between the surface and the underground 
views. 

SHOW BUILDINGS 

Click to toggle on and off the display of all buildings in the 
Work Area. The buildings won't be destroyed, they'll just be 
invisible until you turn them back on. 

SHOW INFRASTRUCTURE 

Click to toggle on and off the display of all Miscellaneous 
Ground Objects, plus power lines, roads and highways, rail 
lines and subway stations. 

SHOW SIGNS 

Click to toggle on and off the display of all signs in the Work 
Area. 

SHOW ZONES  
Click here to toggle on and off the display of all buildings in 
zones. It doesn't affect arcologies or city-owned buildings 
like police and fire stations, educational facilities, depots or 
power plants, but it does affect ports and military bases. In 
underground view, it toggles on and off a color display that 
lets you know where your zones are without going back 
upstairs. 
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The Place & Print 
Menu Bar and 

Information Line 

The SCURK utilities share the same information and many of 
the same menus and menu functions. Each utility also has 
some menu items that are unique to that utility. Here's a list 
of the Place & Print menu items and what they do: 

FILE MENU 
Load has three submenu items: 

City...—Loads a previously saved city terrain for use in 
Place & Print. 

Source Object Set...—Loads a Source Object Set for use 
in Pick & Copy. 

Working Object Set...—Loads a Working Object Set for 
use in all three SCURK utilities. 

Save has two submenu items: 

City—Saves the city terrain used by Place & Print under 
its current name and path. 

Working Object Set—Saves the Working Object Set 
under its current name and path. 

Save As has two submenu items: 

City...—Lets you change the name or path (or both) of 
the city terrain used by Place & Print. 

Working Object Set...—Lets you change the name or 
path (or both) of the Working Object Set. 

New has two submenu items: 

City—Loads an unnamed, blank, flat city terrain for use 
in Place & Print. 

Working Object Set—Loads a clean, unblemished copy 
of the original set as the Working Object Set. 
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Export City...—Exports the city in the Work Area as a BMP 
file (for Windows) or a PICT file (for Macintosh). 

Note: See the SCURK Addendum for any restrictions on 
using the Export City function. 

Print Setup...—Opens a system standard dialog box which 
allows you to change certain aspects of how your printer will 
function. Consult your computer and printer manuals if you 
need help with changing any settings. 

Print City...—Opens a dialog box that 
allows you to print some or all of your 
city. Choose your zoom level from the 
Magnification options then select the 
pages you want to print. You can also 
make changes to your printer setup if 
necessary. 

• The City Map displays an entire 
city area. You won't see any features such as mountains, 
coasts or buildings, but the map itself is positioned the 
same way as your city terrain in the Place & Print Work 
Area. The numbered rectangles indicate what part of the 
city will be printed on one page of paper. The larger the 
magnification level, the smaller the page size and the 
more detail each page will have. Click on pages you don't 
want to print to make them "gray." Click on any those 
pages again if you want to print them. 

• Magnification determines the size of city to print. The 
"lx" option prints pages in the farthest Zoom Out mode, 
"2x" is the medium view, and "4x" is the closest Zoom In 
mode. This magnification level is not based on the zoom 
level you are using in the Place & Print Work Area. 

• Print What gives you the choice of printing the Entire 
Map or the pages you have Selected. If you select Entire 
Map, you can't "turn off" any pages. 
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• The Print button prints the area of the city you have 
defined in the City Map, either the Entire Map, or 
Selected pages. 

• The Setup button opens a standard print setup dialog 
box. You can change several options of printing from this 
dialog box. For best results, you should use Portrait 
Orientation and 8 1/2 x 11 in. 

• The Cancel button closes the print dialog box and returns 
you to the Place & Print Work Area without printing. 

• The Help button opens the Help file if you need assistance. 

Note: Printing an entire city can take as long as five 
hours, depending on Magnification Setting. 

Exit—Closes SCURK (after prompting you to save any 
changes you made). 

OBJECT GROUP MENU 
The Object Group menu lets you choose the group which has 
the objects you want to place. The groups Animated I and 
Animated II are missing from this menu list. Any 
modifications you have made to objects in Animated I or 
Animated II groups will be used in SimCity 2000, but you 
can't place them in Place & Print. 

WINDOW MENU 
Cascade—Overlaps the SCURK utility windows. Click the title 
bar of the utility you wish to use to activate that utility. 

Paint the Town—Activates the Paint the Town utility. 

Pick & Copy—Activates the Pick & Copy utility. 

Place & Print—Activates the Place & Print utility. 

INFORMATION LINE 
This area provides a brief explanation of the highlighted 
Menu item. 
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REGULATIONS FOR CITY PLANNERS 

• All SimCity 2000 Edge-of-the-World restrictions and 
Terrain type and size requirements are in effect in Place 
& Print. Objects that cannot go on the edge of the map in 
SimCity 2000 cannot be placed there in Place & Print; all 
objects require their specific base tile size to be flat 
terrain; the Marina must be placed on at least one water 
tile; Onramps must still be at proper intersections of 
Road and Highway; Subway to Rail connections require 
at least one Rail, a Subway, or another Subway to Rail 
connection. 

• Zoning does not affect where you can place objects. For 
example, if you place a residential building in an 
industrial zone, the land under the residential building 
will be rezoned residential. 

• You can load your old cities and renovate to your heart's 
content. Any and all renovations do not take effect until 
the next time you load your city into SimCity 2000. 

• You can't alter scenarios. Sorry, you'll have to beat those 
on your own. 

• There is no rubble when you demolish something, but 
you can place rubble anywhere you want, if you want. 

• You can't add money to your city's treasury. (Who needs 
money now, anyway?) 

IF YOU BUILD IT, WILL THEY COME? 

Any city you create with Place & Print can, of course, be 
loaded into SimCity 2000. Be forewarned though. The second 
you load it into SimCity 2000, the simulation will start to 
change things according to the whims of the Sims. A city you 
"pre-build" with Place & Print will experience an initial spurt 
of growth when loaded into SimCity 2000. The larger your 
city, the sooner this growth will end. The first Sims who 
move in occupy only a few of the buildings you've provided. 

Place & Print 
Notes and 
Guidelines 
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All the rest of the buildings are considered abandoned. Office 
towers sit vacant as they wait for tenants who are slow in 
coming. Houses are unbought and apartments are unrented. 
There are no workers for the factories. Urban blight spreads 
quickly, which is hardly a selling point for enticing more 
Sims to move to your city. 

The main "practical" and productive uses for the Place part 
of Place & Print are: 

• To modify, customize or otherwise touch up cities that 
you've built in SimCity 2000, 

• To create cities-as-art to print out, 

• To see just how well you understand city design and the 
SimCity 2000 simulator by building a city first and seeing 
if the Sims like it, and 

• To create the playfields for future Maxis driving, flying 
and other games and simulations. 
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A SCURN Tutorial Introduction 
In this brief tutorial, we'll touch on the basic features of each 
of the three SCURK utilities. We will: 

• Start Paint the Town and modify one object (the statue) 
with the paint tools and color cycling. 

• Use Pick & Copy to put some futuristic graphics into the 
SimCity 2000 game. 

• Use Place & Print to make a small city—with our new 
statue and graphics—and print it out. 

In this tutorial, when you see type that looks like this, it is an 
instruction for you to follow. 

Type that looks like this is an explanation. 

By the way, this tutorial assumes that you are familiar with 
SimCity 2000. If you aren't, take some time and play the 
game, then come back to SCURK and this tutorial. It'll make a 
lot more sense if you do. 



Using Paint 
the Tom 

This first part of the tutorial will walk you through the basics 
of using the Paint the Town utility. Here's what we're going 
to do: 

• Start Paint the Town. 

• Locate a particular object (the statue). 

• Modify the object (put a couple of pigeons on top of it, 
then snazz it up with color cycling). 

• Save the modified object for later use. 

Load SCURK. 

Activate Paint the Town. 

Click on the Paint the Town window Grow box to expand the 
utility to its full size and begin the Paint the Town utility. 

When you first enter Paint the Town, you'll see the screen 
below. 

By default, you start with the original set of objects. You'll 
want to draw your own buildings eventually, but for now 
we'll use the original graphics as a base. 
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LOCATING THE STATUE 

When an object set is loaded, the "Large Apartments" object 
of the Residential Group is always the default starting point. 
We want the Statue, which is in a different object group—
Specials. 
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Open the Object Group menu and select Specials. 

You'll now see that the Object Selector looks like this: 

The Statue won't be very hard to find. 

Click on either selector arrow until you see the Statue in the 
Object Selector. 

Click on the Statue. 

Now the Statue is ready for enhancement. 
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FOR THE BIRDS—OUR FIRST DRAWING  
We'll zoom in close and work at the "pixel" level to see what 
we're doing, just like the artists did when the statue was first 
drawn. 

Click the Zoom In tool until it is "ghosted" and you are zoomed 
all the way in. 

Move the right-side scroll bar up until just the top of the Statue's 
head shows.  

Note: The Statue will lose some definition, but the 
three View screens will not change. 

We could draw our pigeon directly on the Statue, but it'll be 
easier to draw it above the statue first, in case we make 
mistakes or have to erase something. We can copy it and 
move it down when we're sure we have it right. 

Click on one of the gray 
colors along the top of the 
color palette.  

An "F" (for foreground) 
appears in the palette 
on the color you chose. 
This color is also the 
color in the Brush Color Box. 

Click the Free Drawing tool (if it isn't already selected). 

Click the smallest brush size (if it isn't already selected).  
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Make sure you are using the Solid texture. 

Here's the pigeon we're going to create (it's a simple bird, 
consisting of only seven pixels): 

Draw a pigeon in the space above the Statue, like the one in the 
picture. 

The sample uses white and two shades of gray, but you can 
use as few or many shades or colors as you want. Just find 
the color(s) you want to use in the palette, click on them 
(one at a time) and draw with them. 

Note: If you draw something that is erased by the 
editor, it means you are outside the Clip Region. If this 
happens, make sure the bottom scroll bar is near the 
center of the bar and try drawing the pigeon lower 
down, closer to the Statue's head. 
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COPYING, PASTING AND ERASING 
Now we'll use the Copy tool to place our work of art on the 
Statue. 

Click the Copy tool. 

Move the cursor slightly above and to the left of your bird. 

Click and hold the left mouse button, and drag the cursor down 
and right to stretch a box around your bird. 

Release the mouse button. 

Your cursor becomes a brush in the shape, size and color of 
our feathered friend. When you move the cursor outside the 
drawing area, it becomes a normal arrow again. 

Use the scroll bars to bring the Statue back into the Drawing 
Area. 

Position your bird-cursor to one shoulder of the Statue like in the 
top picture at the right. 

Click the mouse to paste a copy of your bird onto the Statue. 

Anyone who has seen pigeons knows that there is never just 
one. However, we won't have to draw another one. We can 
flip and rotate our drawing in the clipboard to make a new 
image. 

Open the Edit menu. 

Choose Flip Horiz to make your pigeon-cursor change direction. 

Move the cursor to the Statue's head like in the bottom picture at 
the right. 

Click to paste another bird, this time on the Statue's head. 

Next, we'll remove our initial pigeon, since we don't want it 
as part of our object. 

Use the scroll bars to bring the initial pigeon back into the 
Drawing Area. 
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Click the Erase tool. 

Put the "eraser" end of the cursor on each dot of the test bird, 
and click to remove that dot. 

SAVING YOUR WORK 

Now we're ready to save our work for later use. We don't 

save just the Statue. We must save the Statue as part of a 

new Object Set. 

Open the File menu and choose Save As..., then choose Working 
Object Group. This will open a standard dialog box for saving 
files. 

Let's give this object set the name "Tutorial." Type the word 
"Tutorial" in the file name box. 
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ADDING PANACHE WITH COLOR CYCLING 
SimCity 2000 uses color cycling to create a sense of motion 
and activity. Traffic, tornadoes, water flow, smoke from 
factories—even the drive-in movie—are just a few of the 
objects that use color cycling. See Appendix 1 for more 
information on color cycling. 

We're going to do something a little more modest. We'll use 
color cycling to give the pedestal of our pigeon-covered 
Statue some eye-catching lights. Here's what we're going to 
do: 

• Zoom in to the base of the statue 

• Choose a color cycle pattern 

• Draw our flashing lights 

Click the Zoom In tool to get as close in as you can, 
then zoom out one level. 

Use the Drawing Area scroll bars to bring the left 
side of the pedestal to the center of the Drawing 
Area as pictured. 

The numbered squares in the picture above are 
where we will add our color-cycling lights. 

First, let's change our brush size. 

Click the next-to-smallest brush size, then click the Free Drawing 
tool. 

Note: Since our brush size is larger, it might be a tad 
more difficult to position the brush properly. Use the 
Undo option from the Edit menu if you put a dot in the 
wrong place. 

Now let's get our color cycle pattern. The color cycles are all 
gathered together at the bottom of the Color Palette. 

Scroll the color palette until you see the color cycle patterns. 
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Click the first color of the four-color "red-yellow-brown-brown" 
cycle pattern. 

Place the brush in the center 
of square one and click to 
place your first flashing dot. 

Click the second color of the 
pattern in the Color Cycle 
Display. 

Click on square two to place 
your second flashing dot. 

Click the third color of the pattern, and place this color in square 
three. 

Choose the fourth color of the pattern, and put it in square four. 

We're at the end of the pattern, but we still have more 

squares to work on. To make a cycle which is longer than the 

length of the pattern, start the pattern over with the first 

color. 

Click the first color of the pattern, and place this 
color in square five. 

Put the second color of the pattern in the square 
six. 

Finally, put the third color of the pattern in 
square seven. 

Now we have a lovely set of running lights 

along the base of the statue. 

All we need to do now is save our work and 

we're ready for the next step. 

Open the File menu and select Save, and then 
select Working Object Set. 
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In this part of the tutorial, we'll: 

• Start the Pick & Copy utility. 

• Pick some objects that have interesting graphics. 

• Copy these graphics to another object set which we will 
use in the SimCity 2000 game. 

Click the Pick & Copy window grow box 
to expand Pick & Copy to the full size of 
your screen. 

The Statue we modified is already in 
the Working set. In order to embellish 
it further, we'll use some graphics 
from the Future graphics set. 

Open the File menu and select Load.... 

Select the Source Object Set submenu 
item. 

Choose the Future object set. 

At the top of the screen are objects 
from the source object set (Future), and at the bottom are 
the equivalent objects of the Working Object Set. 

Our statue would look best if it were 
surrounded with a few municipal 
buildings, such as a city hall and a 
museum. These buildings are in the 
Specials object group. 

Open the Object Group menu and select 
Specials. 

Click either Selector Arrow until the Zoo 
and Museum appear in the Selectors. 

While holding down your Ctrl key, click 
on the Museum, then the Zoo object in 
the Source Object Set. 

Using Pick & Copy 
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The Zoo and Museum objects in both the Source and the 
Working Selectors are now active. Now we'll build our 
Working set by adding these new graphics to it. 

Click and hold your mouse, and drag the selected objects to the 
Working Object selector. 

As soon as your mouse cursor enters the Working Object Set 
selector, the Working objects which correspond to the 
Source objects you selected will highlight. Don't worry about 
lining up the specific Source objects with the Working 
objects. SCURK will make sure that the graphics are put in 
their proper place. 

Release the mouse button to finalize the copying. 

You'll be asked to confirm that you want to copy the 
Museum and Zoo tiles. Click the OK button. The future 
graphics we selected are now a part of our working set. Of 
course, since we have made a change to our Working set, we 
should save our work again. 

Open the File menu and select Save, then select Working Object 
Set. 

When prompted, choose Yes to Overwrite existing file. 

That's all there is to it. Your new Statue can now be 
displayed the next time you start SimCity 2000. But why 
wait? Let's put them to use in Place & Print. 

Open the Windows menu and select Place & Print. 
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In this part of the tutorial, we'll: 

• Start the Place & Print utility, 

• Build a tiny city that will display our modified Statue and 
the objects we copied, 

• Save our work as a city that can 
be loaded into SimCity 2000, 
and 

• Print it out. 

We're now looking at a new, blank 
city. 

First, we'll put down some roads—
just the same as you would in 
SimCity 2000. 

Click the Road tool in the toolbox. 

Place some roads in the Work Area. 

Now we'll use the Object Selector at the bottom of the 
screen to place some objects. Let's get to the Specials 
section and place some of those futuristic buildings. 

Open the Object Group menu and select Specials. 

Click on either of the Object Selector arrows until we see 
our statue and the buildings we have copied. 

Click on the Statue to select it, then place a few in the Work 
Area along one of the roads. 

Now let's make them the centerpiece of a plaza of the 
future. 

Using Place a 
Print 
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Click on the Museum object and place one 
or two near the statue. 

Click on the Zoo object and place it near 
the museums. 

That's all there is to using the Object 
Selector: select the object group, select 
the object, place the object in the Work 
Area. Simple. 

Obviously, this isn't much of a city, so if 
you want to spend some time adding 
roads, modifying the terrain with the 

Bulldozer tool and placing more objects, go right ahead. 
We'll wait here for you. Come on back when you're ready to 
save the city to disk and print it out. 

SAVING YOUR CITY 
Now to save the city. 

Open the File menu and select Save City. 

This dialog box will open: 

Type in a name for your city in the city name text box. 

Click on your choice of Easy/Medium/Hard and the 
Year. 

Click on the Done button. 

Our City is now saved and ready to load into SimCity 2000. 
Now let's print it out. 

Note: If you don't have a printer hooked up to your 
computer, you'll want to skip this part and jump ahead 
to the Farewell section. 

Open the File menu and select Print City... to open the Prints of 
the City dialog box. 
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This opens the print dialog box. You can 
print your city in three sizes, matching the 
three zoom levels in SimCity 2000. The 
Large size (4x) is so big, it takes over 20 
pages to print the whole city in the sharp-
est detail. In Medium (2x), you can print 
your whole city in eight pages, and Small 
(lx) will fill two pages, but you won't see 
very much detail. 

Luckily, you don't have to print the whole city. In fact, the 
city we have made is small enough to fit on a few pages in 
the Large size. Let's print it. 

Click the 4x Magnification option. 

Click on the Selected button under "Print What." 

It may be a little hard to determine where your buildings are 
on the city map. If you've put your Plaza near the center of 
the map, you should turn "off" the pages near the edge so 
you don't have to wait for them to print. 

Click the Print button. 

Printing will begin. This may take a while, depending on your 
computer, your printer and the complexity of your city. If 
you want to halt the printing process, press the Esc key (or 
Command (.) on the Macintosh). 

Printing one page is nice for a small city, but printing a larger 
area is also easy. Just click and drag the page-sized cursor 
across the part of the city you want to print. The pages will 
be marked and numbered. Don't worry about overshooting 
the map—any pages that are off the map won't be printed. 

Or if you want to print the whole city, don't bother with the 
map or the cursor at all. Just click on the Entire Map option. 
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Farewell 
That's it for the tutorial. You should now be able to use 
SCURK and customize cities to your heart's content. But if 
you want more help or details, check out the rest of this 
manual. It explains every button, tool and function, and has a 
lot of helpful hints and tips that will make your time with 
SCURK more fun and more efficient. 

Happy SCURKing! 
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Appendix: Colors, the Palette 
and Color Cycling 
These days, Macintosh, DOS and Windows all support 
thousands, if not millions of possible colors, but these 
systems usually limit the number of those colors that can 
appear on the screen at a time. Most computer games these 
days support either 16 or 256 simultaneous colors. 

The more colors you want to display at a time, the more 
memory it requires to hold that information—that's memory 
in RAM, memory on the hard disk, and memory on the floppy 
disks [or CD-ROMs] that the program comes on. In addition 
to memory requirements (and the cost of the extra disk 
space), displaying thousands or millions of colors at once 
slows down the computer, because it has to move so much 
more information around in memory and draw it on the 
screen. 

The palette is the set of all the colors available in a particular 
program; it is chosen by the art director, with input from the 
programmers. You can think of it as an electronic version of 
the painter's palette, where the artist mixes colors. What it 
actually is, is a lookup table for the computer. It has one 
column of numbers, from 0 to 15 for a 16-color palette or 
from 0 to 255 in a 256-color palette. In another column are 
the instructions for mixing that color out of red, green, and 
blue (RGB). 

Programmers don't have to spell out the RGB formula for 
each pixel (dot) drawn on the screen, they just say make this 
pixel color 127, and the computer will look up the color on 
the palette. 
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The palette can be customized for each program and 
changed while a program is running. If you change a color 
definition in the palette, say change color 192 from blue to 
red, then every instance of color 192 on the screen will 
change from blue to red. This change happens very 
quickly—much more quickly than having the computer 
search every dot to find out which ones are color 192 and 
changing them to another color—and takes very little CPU 
time, so it doesn't slow down the action in the game. 

Color cycling is a technique that takes advantage of the 
power, speed and flexibility of changing color definitions in 
the palette to create effects or animations. SimCity 2000 uses 
color cycling to create, among other things, the animations 
of traffic on the road, the smoke from the factory 
smokestacks and the flashing lights on the title screen. 
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